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Setting Barricades Utilizing GIS Data or Manually

1. Introduction

After the ESS database has been developed and GIS, RPI, and PES data sets have been imported, the
next step is to setup barricades that exist between PES and ES facilities. If the GIS data contains a layer
with features representing barricades, ESS can use this GIS layer to automatically detect were
barricades occur between the PES and ES facilities. As an alternative, barricades can be manually
setup without the use of barricades in the GIS data. This first section of this guide describes the
procedures for using existing GIS data (Shape files or geodatabase) to automatically detect
barricades between PES and ES facilities. The second section of this guide describes procedures for
manually setting barricades where necessary.

A. Refer to DA PAM 385-64, Ammunition and Explosives Safety Standards, 16-25.
Barricades and Earth Cover for Magazines

B. REMINDER: Barricades are effective in protecting ammunition or explosives, structures, or
operations against high-velocity, low-angle fragments although the barricades may be
destroyed in the process. Since such fragments move along ballistic trajectories rather than
straight lines, reasonable margins in barricade height and length must be provided beyond
the minimum dimensions that block lines of sight. Barricades also provide limited protection
against blast in the immediate vicinity. They do not protect against high angle fragments and
are ineffective in reducing the blast pressure in the far field (IBD or PTRD).
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2. Detect Barricades & Perform Spatial Analysis

Note: ESS uses a spatial analysis to detect barricades between PES and ES facilities. Up to this point in the
guide, a spatial analysis has not been run. When we run the Detect Barricades menu option, it will run a
spatial analysis before going through the procedure of detecting any barricades.

A. Go to the ESS Main Tool Bar then click on Database Builder > Barricades > Detect Barricades as
seen in the image below.

File | Database Builder | Edit Properties FReports  Analysis  View  Admin Record
AR Mew Database Wizard P (i) T | AddLayer - ‘& |Scale: 1

B & Installation Settings

Folder Paths 3
Measurement Units

Analysis Settings

GIS Setup
Map Layers F
Output Layers k
RPI Data r
PES Data r
= Default Classification
. Cat Code/Type Code Editor
Assign Fronts k s
= Barricades » Detect Barricades
= Related » Fadlity Barricading
Fadility Data » PES ES Barricaded Report
- Log File Browser Reset PES ES Barricades
Reset Database '
Compare Two ESS Databases
> . B 000 x|

A ESS has detected that some fadilities require a spatial analysis
y' prior to barricade detection. Do you want to run a spatial

- .
analysis?

I Yes I Mo Cancel

B. On the Detect Barricades window, click on YES to continue:
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C. You may get a warning message in the Spatial Analysis Validation Warning window indicating
there are facilities missing a Type Code, and will automatically assign them the IHB (inhabited
building) type code. Do not worry about this at this point. You can review the logs and it will
identify which facilities were assigned the IHB type code and after the analysis is completed you
can go back in and change the facilities to the desired type code. Click on OK to continue:

! iy Print - = Expart -

The following Validation Wamings were encountered.
Press OK to continue, or Cancel to abort

1030
1020
1021
1022
1023
1024
1025

Harning: 100 facilities were found in the datebase without a typecode. These
facilities will default to IHE until a2 typecode is assigned.
You may use the Catcode/TypeCode Editor to correct these fecilities.

[LI5>

[ £

QK Cancel

D. You will now see a progress window called Analysis. The Spatial Analysis is in progress. Be
patient as this may take a while. (If it is a big base...a long while) As the process is ongoing, it
will show a status for each task under the status column as seen below.

B _ e ._ ﬂ_
E | i
Task | Status | Log | Emors | |
Facility Shape Analysis In Progress [Miew Log]
PES ES Spatial Analysis Pending ;
|Update Facility Analysis States Pending
Facility Shape Analysis - 5 of 14671
Click here to view the log for this process Cancel
|
L
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E. Upon completion of the analysis you may see this Analysis dialogue box, click OK.
o [ ]
x|

£

4 Errors encountered!
i Please review the error logs for more information.

[ o< 1]

F. When the process is complete, you will see several links to view three different, but

important logs in the Analysis window. Any of the rows could have these logs depending on
errors encountered.

1. Note the Facility Shape Analysis row: There are two logs. The third log is located in

thebottom left corner of the Analysis window highlighted in blue. Lets review these three
logs in the pages to follow.

|

Task | Status [ Log [ Erors

Facilty Shape Anahysis Complete | [View Log] [View Log]

PES ES Spatial Analysis Complete

Update Facility Analysis States Complete

Operation Complete
Click here to view the lo for this process Done |
ESS Reference Guide, Setting Barricades Page 6 of 34
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2. In the Analysis window under the Log column click on the link, View Log. See next page.
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3. You will now see the Facility Shape Analysis 130504237610501663.txt-notepad log
file below. This file allows you to view which facilities were evaluated for barricades. To

close this file, click on the X in the upper right corner.

cility Shape Analysis 130504237610501663.bx¢t - Notepad

Created
Created
Created
Created
Created
created
Created
Created
created
Created
Created
created
Created
Created
created
Created
Created
Created
Created
Created
Created
Created
Created
Created
Created
Created
Created
Created
created
Created
Created
created
Created
Created
created
Created
Created
created
Created
Created
Created
Created
Created
Created
Created
Created
Created
Created
Created
Created

search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search
search

Zone
Zone
zZone
Zone
Zone
Zone
Zone
Zone
Zone
Zone
Zone
Zone
Zone
Zone
zone
Zone
Zone
Zone
Zone
Zone
Zone
Zone
zone
Zone
Zone
zZone
Zone
Zone
Zone
Zone
Zone
Zone
Zone
Zone
Zone
Zone
Zone
Zone
zone
Zone
Zone
Zone
Zone
Zone
Zone
Zone
Zone
Zone
Zone
Zone

Eatch started at 7/21/2014 8:42:41 AM.

'Front’ for facility 1
'Right’ for facility 1
‘Rear’ for facility 1
‘Left’ for facility 1
'Front’ for facility 2
‘right’ for facility 2
'Rear’ for facility 2
'Left’ for facility 2
'Front’ for facility 3
'Right’ for facility 3
'Rear’ for facility 3
‘Left’ for facility 3
'Front’ for facility 4
'Right’ for facility 4
‘rear’ for facility 4
'Left’ for facility 4
'Front’ for facility 5
'Right’ for facility 5
'Rear’ for facility 5
‘Left’ for facility 5
'Front’ for facility €
'Right’ for facility 6
'Rear’ for facility 6
'Left’ for facility 6
'Front’ for facility 7
'Right’ for facility 7
'Rear’ for facility 7
‘Left’ for facility 7
'Front’ for facility 8
'Right’ for facility 8
'Rear’ for facility 8
‘Left’ for facility 8
‘Front’ for facility 9
'Right’ for facility 9
'rear’ for facility 9
‘Left’ for facility 9
'Front’ for facility 10
‘right’ for facility 10
'Rear’ for facility 10
‘Left’ for facility 10
'Front’ for facility 11
'Right’ for facility 11
‘Rear’ for facility 11
‘Left’ for facility 11
'Front’ for facility 12
'Right’ for facility 12
'Rear’ for facility 12
‘Left’ for facility 12
'Front’ for facility 13
'Right’ for facility 13
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4. You are now returned to the Analysis window.

_ A

Task | status | Log Ermors
Facility Shape Analysis Complete | [View Log] Miew Log]
PES ES Spatial Anahysis Complete
Update Facilty Analysis States Complete

Operation Complete

Click here to view the log for this process Done |

A

5. In the Analysis window above, look at the Errors column and click on the link called

View Log. If you have no report in this column then you have done a good job at
QC'ing your data.
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6. You will now see report name Facility Shape Analysis Errors
130504237610813663.txt-notepad. When done with this report, click the X in the upper
right corner.

! Facility Shape Analysis Errors 130504237610813663.bxt - Notepad o |m 5'
Flie cal orma viEW Help
This is not a rectangular magazine. =]
Facility Number: °5P406°
Facility ID: "bldg_1325'
Layer: ‘structure_existing_area’
This is not a rectangular magazine.
Facility Number: ’5P001°
Facility ID: "bldg_1332°
Layer: "structure_existing_area’
This is not a rectangular magazine.
Facility Number: *50707°
Facility ID: "bldg_1358°
Layer: “structure_existing_area’
This facility does not have a valid geometry (empty shape detected).
Facility Number: "ACR-85'
Facility ID: "bldg 2475’
Layer: “structure_existing_area’
This facility does not have a valid geometry (empty shape detected).
Facility Number: "ACR-87'
Facility ID: 'bldg_2498°
Layer: “structure_existing_area’
This facility does not have a valid geometry (empty shape detected).
Facility Number: "ACR-8B8'
Facility ID: "bldg_2499°
Layer: “structure_existing_area’
2

7. You are now returned to the Analysis window seen on the next page.
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8. In the Analysis window below there is one more link to view yet another log. In the
bottom left click on the link called Click here to view the log for this process. This will
open up the final log as seen on the next page.

f

Task | Status [ Log | Ermors |
Facilty Shape Analysis Complete | [View Log] [View Log]
PES ES Spatial Anahysis Complete
Update Facilty Analysis States Complete
Operation Complete
[Gick here to view the loa for this process Done |

ESS Reference Guide, Setting Barricades
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9. In the Analysis window below this log simply provides you a summary of the analysis

run time in hours: minutes: seconds.

: ¢4 Print ~ [ Export ~

El

Beginning analysis at 8:4Z:41 BM

Facility Shape Rnalysis 126858 _.278s3
BES ES5 Spatial Bnalysis 12607 .38563
Update Facility BRnaelysis States 0.84Z4s

Total Buntime: 07:01:0&_50&80000

=

10. When done with this report, click the X in the upper right corner of the analysis

window seen above.

Task [ status [ Log | Erors |
Facility Shape Analysis Complete | [View Log] [View Log]
PES ES Spatial Analysis Complete
Update Facilty Analysis States Complete
Operation Complete
Chlbe b S e

ESS Reference Guide, Setting Barricades
ESS v6.1, B238C

11. Upon closing the log
above you are returned
to the Analysis
window. If finished
click the Done button.
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Note: Now that the spatial analysis is complete, ESS will proceed with detecting barricades.

G. Upon closing the Analysis window on the previous page you now have the Barricade
Options window open. Note: There are two versions you might encounter: The image on
the left you will encounter when the installation has no Barricade shape file. In this case,
you will have to work through the structure_existing_area shape file. The image on the
right you will encounter if the installation has an existing Barricade shape file.

Barricade Options 5 # Barricade Options 3]

; Select the layers to be searched for bamicades: Select the layers to be searched for baricades:
] road_centedine [ structure_existing_area ~
! [[] railnoad_centerine [] slab_area
| || structure_existing_area I

|| installation_area electncal_cable_line __
‘ [] road_centerline

[] rairoad_centerline v
|
l Analyze: Analyze:
: & Al Facili (%) Al Facilities
: " Aset of PES Facilties () A set of PES Facilities
| " Aset of ES Facilties B | O A set of ES Facilties
|
|
!
|
ok | Cancel | [ ok [ cancel

H. In the Barricade Options window you will select the appropriate file containing your
shape file for the barricades. If you are unsure of which file it is, consult with the
Installation Directorate of Engineering Division, Master Planner/GIS POC.

I. In the Barricade Options window center you
Select the layers to be searched for bamicades: . .
TP e will see a box called Analyze. Select the option
[ railroad_centedine called All Facilities. Click OK when done.

1™l structure existing area
[[] installation_area

Analyze:

 Aset of PES Facilties
" Aset of ES Facilties
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J. You will now see the Detect Barricades progress window open.

e 5

Processing tem 45 of 35786

_ Cancel |

Click here to view the log for this process

K. Once the detection process is complete you can either view the log or click Done.

Detect Barricades " ﬂ

Batch Finished

Done

IEid{ here to view the log for this process I
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L. This will automatically open the Barricades Detected During Analysis window. You can
view the data in this window and export it if necessary.

Barricades Detected During Analysis
: ¢ Print Table ~ Search: | Columns ~ |
ES e |rsse  |ose
» B o NA NA
o017 00007 NA NA
00045 BCEX3 NA NA
00045 5DEX32 NA NA
| D0OM1 000M2 NA NA
| DDOM1 000M3 NA NA
00OM1 41107 NA Rear
DOOM1 41102 NA Rear
| D0OM1 41201 NA Right
| 00OM1 41201 NA Rear
DOOM1 41202 NA Right
DOOM1 413071 NA Right
| 00OM1 41302 NA Right
0OOM1 414071 NA Right

M. When done with this report, click the X in the upper right corner. You are now returned
to the ESS main window.

Fle DotsboseBulder Edit Propertes Reports Andhysis View AdminRecord Toos  Help,

NQQEB@E- (DM s OF | Adlayer - Qs 15000 - |Edtor: 4 X 1 [ [ € Markup -

< 3
[223980.47, 385393790 Data Chedk
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N. If later in your work progression you desire to review this data you can find it in the following
location: Main Tool Bar>Database Builder > Barricades > PES ES Barricaded Report.

File | Database Builder || Edit Properties FReports  Analysis  View  Admin Re
S @ Mew Database Wizard h (i) i | Add Layer = '& | Scale:
EE= Installation Settings
Folder Paths »
Measurement Linits
Analysis Settings
GIS Setup
Map Layers 3
QOutput Layers 3
RPI Data k
PES Data k
= Default Classification
- Cat Code/Type Code Editor
Assign Fronts 3
= Barricades b Detect Barricades
= Related r Fadility Barricading
- Fadiity Data » PES ES Barricaded Repart
Log File Browser Reszet PES ES Barricades
Rezet Databaze
Compare Two ESS Databases
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3. Manually Set Barricades

NOTE: If GIS data does not exist for barricades, they can be set manually. This part of the guide will
describe the process steps for setting barricades between PES and ES facilities.

A. Examples of Barricaded Buildings as you will see them in ESS versus other sources:

[ S S

ESS Image #1 Y-Site: AGM Google Earth Image #1 Y-Site: AGM

ESS Image #2 Production Building: EOL Google Earth ESS Image #2
Production Building: EOL

ESS Reference Guide, Setting Barricades Page 17 of 34
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ESS Image #3 ECM: Front Barricade Google Earth Image #3 ECM: frontal Barricade
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DatsbaseBulder Edit Properties Reports Analysis  View  AdminRecord Tools  Help
iﬂQQ\EIE‘Oﬂvlévﬂ g (0 7| Addiayer ~ ' |scale: 11250 - Edtor 4 X [H @D Markp -

=] railroad_centerline

[ [ structure_existing_area
O

=] installation_area

= @ ortho_1-1_In_s_ok121

B. Use the Zoom In button to zoom into the area of the map that contains the barricaded
facilities. In the example above, PES 11202 has a front, side and rear barricade and the
surrounding ES's have a front, side and rear barricade.

NOTE: If you look at the left side of the ESS main window you will see that no Barricade shape file is
available. we are having to utilize the Structure_existing area shape file for this installation. Therefore
we will manually assign the barricades to PES 11202.

ESS Reference Guide, Setting Barricades Page 19 of 34
ESS v6.1, B238C



C. In the ESS main window, select the Database Builder > Barricades > Facility Barricading

menu option.

ESS Reference Guide, Setting Barricades
ESS v6.1, B238C

ﬂi Mew Database Wizard b (i) T | Addlayer - '& | Scale:
=R= Installation Settings
Folder Paths »
Measurement Linits
Analysiz Settings
GI5 Setup
Map Layers 3
Output Layers 3
RPI Data 4
PES Data 4
= Default Classification
. Cat Code/Type Code Editor
Assign Fronts 4
e TTTTN]  octecticates
= Related v | Fadity Barricading
g Fadility Data 5 PES ES Barricaded Report
Log File Browser Reset PES ES Barricades
Reset Database
Compare Two ES5 Databases
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D. The Select a Facility for Barricading window below is now open.

ESS Reference Guide, Setting Barricades

ESS v6.1, B238C

| Fadiity Filter: | Columns = < Print ~ [ Export ~ Batch -

o o i (B [

bldg_. structure_existing_area
bldg_2078 |00ODZ IHE structure_existing_area
bldg_2075 | 00003 IHB structure_existing_area
bldg_2081 00004 IHE structure_existing_area
bldg_2079 | 00005 IHE structure_existing_area
bldg_2467 | 00OD6 IHE structure_existing_area
bldg_2090 | 00007 CALIER... |EOL structure_existing_area
bldg_2472 | 00003 IHE structure_existing_area
bldg_2058 | 00005 IHE structure_existing_area
bldg_2400 |00010 IHB structure_existing_area
bldg_2055 | 00011 IHE structure_existing_area
bldg_2087 |00012 IHB structure_existing_area
bldg_2118 |00013 IHE structure_existing_area
bldg_2085 |00014 IHB structure_existing_area
bldg_2115 | 00015 IHE structure_existing_area
bldg_2088 | 00016 IHE structure_existing_area
bldg_2113 | 00017 EQOL structure_existing_area
bldg_2086 | 00018 IHE structure_existing_area
bldg_2116 | 00019 IHE structure_existing_area
bldg_2092 | 00020 CHEML... |IHB structure_existing_area
bldg_2403 | 00021 FAC structure_existing_area
bldg_208% |00022 IHE structure_existing_area

oK I Close
14671 rows found.
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E. In the Select a Facility for Barricading window, type in the facility number in the Facility
Filter box. To select a specific barricaded facility click one time on the row and it will turn blue
highlighting the selection.

Select a Facility for Barricading ﬂ
I;Fadityﬁlher: 11202 ||Cokmxsvf@Pmtv|EEnq:ortv Batch ~ |

3 bldg 1

I 2 L o

structure area

I 0K I Close

2 rows found.

F. When selection has been made click OK.
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G. The Facility Barricading window is now open.

Facility Barricading

:| Add Facilities ~

Facility 'A' Details:

Facility MNumber:

11202

Facility Name:

Type Code: ECM

Description:

Category Code: 42180

Internal OID: 4350

Facility 'B' List:

11203

ECM

Facility No /| Description Intemal 1D Type Code A Barmicaded B Bamicaded
11101 482 ECM I W
11102 489 ECM i 3
11201 483 ECM ¥ M
v v

IR o

IR o

oK Cancel

NOTE: If you refer back to the image associated with step 3B you will see that ECM 11301 is Identified,
but is not identified in the listing above. You will manually assign the barricade criteria in the following

steps.

H. In the Facility Barricading window, click on Add Facilities and then Selected From Map.

Facility Barricading
| Add Facilities v||

Selected From List

Selected From Map

Facility Name:

Description:

Category Code: 42180

Internal OID: 450

ESS Reference Guide, Setting Barricades
ESS v6.1, B238C
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I. The Facility Selector window is now open.

NOTE: There is two methods of selecting the facilities you want in this window.

1. Take your mouse cursor while holding down the left mouse button and drag the cursor around all the
facilities you want to select. As you drag the cursor you will see an box appear.

2. Take your cursor and select each facility individually by clicking on them.

ESS Reference Guide, Setting Barricades Page 24 of 34
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J. Upon selecting the facility you will see the facility polygon become highlighted and the facility
will be added to the bottom window of the Facility Selector.

K. Take your cursor and select the facility. The selected facility will be highlighted in blue. Click OK
when done.
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L. The Facility Barricading window is now displayed with the ES facility records that were
selected.

Facility Barricading ﬂ
: Add Fadlities ~
Facility 'A' Details:

I]Facj_litg Humber: 11202 | Facility Hame:
Type Code: ECM Description:
Category Code: 42180 Internal OID: 420

Facility 'B' List:
Facility No /| Description Intemal 1D Type Code A Banicaded B Banicaded
11101 482 ECM I v
11102 433 ECM v v
11201 433 ECM I~ v
11203 488 ECM v v
11301 485 ECM r r

- [11302 491 ECM [ | I
11303 487 ECM ¥ v
11401 484 ECM v v
11402 501 ECM I~ v
11403 492 ECM v v
BECY24 1648 AGM I~ v
BECY25 1647 AGM v v

ok | cancel |

NOTE: You will notice there are columns listed for “A Barricaded” and “B Barricaded.” A Barricaded
refers to the main PES 11202. B Barricaded refers to the ES facilities. If the barricade is part of the main PES
the A Barricaded column should be checked. If the barricade is part of the ES, the B Barricaded column
should be checked. Refer to examples provided on the next page. These are examples of barricading
scenarios you might encounter.
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Examples of when A Barricade and B Barricade are checked:

EXAMPLE #1
A=11202 B=11101
Faciy‘No Intemal 1D Type Code A Bamicaded B Bamicaded
11101 482 ECM v v
EXAMPLE #2
A=11202 B=11102
Facility No ¢ | Description Intemal 1D Type Code A Bamicaded B Bamicaded
11102 439 ECM W ¥
EXAMPLE #3
A=11202 B=11301
| | Faciity No ¢ | Description | Intemal ID | Type Code | A Bamicaded | B Banicaded |

ESS Reference Guide, Setting Barricades Page 27 of 34
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EXAMPLE #4

Operating Building Barricade Operating Building
A B
Facility No /| Description | Intemal ID | Type Code | A Bamicaded | B Bamicaded
OO | o | EOL L :
EXAMPLE #5

Operating Building Barricade Barricade Operating Building
A B
Facility Mo + | Description | Intemal ID | Type Code | A Bamicaded | B Bamicaded |
OO MK | EOL L s |
EXAMPLE #6

Fragment Producing Inhabited Building

Explosives In The Dpsn
A B
Facility Mo ¢ | Description | Intemal 1D | Type Code | A Bamicaded | B Barmicaded
UMM | | oo | AGHM [ ] | ]
ESS Reference Guide, Setting Barricades Page 28 of 34
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M. In the Facility Barricading window go to the Facility No column and click once on Facility
number 11301. This will highlight the 11301 record in blue. Go to the A column and click on the
check box then go to the B column and click on the check box.

Facility Barricading ﬂ

. Add Fadiities -

Facility 'A' Details:

Facility Number: 11202 Facility Name:
Type Code: ECH Description:
Category Code: 42180 Internal QOID: 450

Pacility 'B' List:
Facility Mo ¢ | Description Irtemal 10 Type Code A Bamicaded B Bamicaded
11101 482 ECM 0 ¥
11102 439 ECM W 3
11201 483 ECM W ™
11203 ECM 7 ™3

IR
IR

oK Cancel

N. Click the OK button when complete.
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NOTE: In the Facility Barricading window you know that everything in either column A or B is
supposed to be checked. If you want to verify that, you can right click on the A or B column and
then choose one of the three options seen below. When done click on the OK button.

Facility 'A' Details:

E

: Add Fadilities -

Facility MNumber: 11202

Type Code: ECM

Facility Name:
Description:

Category Code: 42180

Internal OID: 450

Facility 'B' List:

B —
Facility Mo Description Intemal 1D Type Code ‘Al in this Col
11101 432 ECM ¥

Select Mone in this Column
11102 483 ECM v .

Invert Selection in this Column
11201 483 ECM i '
11203 438 ECM W ¥

SIS

SRR

O. Manually setting the barricades is no complete.
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P. To view the barricades report, go to the ESS main tool bar use the Database Builder >
Barricades > PES ES Barricaded Report menu option. After clicking on the menu option, be

patient as it may take awhile depending on the size of your installation.

File [ Database Buider | Edit Properties Reports Analysis View  AdminR
@ MNew Database Wizard b (i) T | AddLayer - '§ | Scale
SE= Installation Settings
Folder Paths »
Measurement Linits
Analysis Settings
GIS Setup
Map Layers 3
Output Layers 3
RPI Data 8
PES Data 8
= Default Classification
- Cat CodefType Code Editor
Assign Fronts 3
= Barricades r Detect Barricades
= Related 4 Fadility Barricading
- Facility Data » |___PesEsBarricadedRepart |
R Reset PES 5 Barricades Close the report when finished.
Reset Database
Compare Two E55 Databases
Q. Below is the PES ES Barricaded Report. You can view all barricaded faciltiies within this
report and easily export to a number of formats using the Save Report drop down menu.
When done with the report go to the upper right corner and click on the small X.
: [ Save Report + &5 Print ~ | Columns ~ | Search: m
N R e B R
> NA Tue True on017 NA
00045 NA True True 5DEX32 NA
00045 NA Tue Tue 5CEX31 NA
0noM1 NA Tue Tue 4120 Right
0DoM1 NA True True 0oomM3 NA
00oM1 NA True True ooomMz2 NA
00omM1 NA Tue Tue 41302 Right
00oM1 NA True True 41202 Right
0D0M1 NA Tue True 41201 Rear hd
20903 rows displayed.
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R. To visually see which facilities are barricaded, go to the ESS main tool bar>View > Display > PES
ES Barricaded menu option. See the next page.

File DatsbaseBuider Edit Properies Reports Analysis | View | AdminRecord Tools Help

e B @@E- S M DI adg  Dsplayarcs

[ = Map Layers Select PES Analysis to Draw

[] editor: 4 % 1 [ 0O

[ ExpFx Draw Last Analysis
[ K_Factar
[] Placement Advanced Arc Filter
[J Dimensiens Draw All ESQD Arcs
O violations
O Mitigations Draw IBD Composite Arcs
Arcs Buffer Features
[ IBD_Zones
O Spatial_analysis
[ Fadlity_Shapes - .
[] Evaluation_Zones Show Spatial Analysis Zones
O Spatial_Analysis_Zones Show Eval Zones Railways
=] road_centerline Show TED Z avs
= railroad_centerline Waterways
=] structure_existing_area Basic Category Codes
[ Fadility Class
= Sﬁllaﬁm_ﬁrea Fadiity Fronts
B ortho_1-1_1n_s_ok121 | Hazard Divisions
RGE PES-ES Barricaded
Il FRed: Band_1 RS
[ Green: Band_2
M Blue; Band_3 Type Codes
Reset Display
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S. In the Select the barricaded PES to display window below, type the facility number in the
Facility Filter input box. Click the OK button. You are now returned to the ESS main
screen. See the next page.

Select the barricaded PES to display
! Faciity Filter: 11202

Facility
ID

Columns - E-..I'ﬁ Print - E Export = Batch -

bldg CALIBRATION LAB | EOL

bldg_2113

bldg_1702 00045 CELESTIMNE DEPOT | AGM
bldg_1662 0oomM1 MISSILE M1 AGM
bldg_1663 ooomz2 MISSILE M2 AGM
bldg_1664 0DOM3 MISSILE M3 AGM

Ok Cancel
1997 rows found.
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T'. Lines will be displayed on the screen showing which ES facilities are barricaded for
PES 11202. To clear the lines,use the ESS Main Tool Bar>View>Display> Reset

Display menu option.

ilder  Edit  Prop Reports  Analysis  View  AdminRecord Tools  Help

ﬂQQ\ElEloa |G- LD addiayer - g scal: Mmmr 4 X B D vk -

= rairoad_centerline

= structure_existing_area
=

=] installation_area

o
= ortho_1-1_1n_s_ok121 |

This concludes the setting barricades guide.
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